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Hardware

Kelengkapan hardware workshop :

1. Antares LR201Board

a. Controller

b. Antenna
2. Antares Shield

a. Relay (D)

b. Push Button (A0)

c. DHT 11 (Temperature Humidity Sensor) (D4)
3. Kabel Data Micro USB



Spesifikasi Antares LR201 Board

Compatible with 3.3v
Frequency Band: 915 MHZ
Low power consumption
Compatible with Arduino IDE

168 dB maximum link budget.

+20 dBm - 100 mW constant RF output vs.
+14 dBm high efficiency PA.
Programmable bit rate up to 300 kbps.
High sensitivity: down to -148 dBm.
Bullet-proof front end: IIP3 = -12.5 dBm.

PIN FUNGSI PIN FUNGSI
SCL
SDA
AREFF
GND
D13 LORA CLK
D12 LORA MISO
RST D11 LORA MOSI
3.3V D10
5V D9
GND D8
GND D7 LORA DIO2
VIN D6 LORA DIOI
A0 D5
Al D4
A2 D3
A3 D2
A4 TXD
A5 RXD




DHT11
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Sensor Kelembapan dan Temperature DHT11

DHT11 merupakan sensor kelembapan dan temperature yang memliki spesifikasi seperti

berikut :

e Ultra low cost

e 3to5Vpowerandl/O

e 2.5mA max current use during conversion (while requesting data)
e Good for 20-80% humidity readings with 5% accuracy

e Good for 0-50°C temperature readings +2°C accuracy

e No more than 1 Hz sampling rate (once every second)

e Body size 15.5mm x 12mm x 5.5mm

e 4 pins with 0.1" spacing



Relay

DA . M

10A 250VAC 10A 125VAC
10A 30VDC 10A 28VDC

 SRD-05VDC-SL-C |31

Relay

Relay adalah suatu peranti yang menggunakan elektromagnet untuk mengoperasikan
seperangkat kontak sakelar. Relay terdiri dari kumparan kawat penghantar yang dililit pada inti
besi. Bila kumparan ini diberikan energi, medan magnet yang terbentuk menarik armatur

berporos yang digunakan sebagai pengungkit mekanisme sakelar magnet.

Software

Perangkat lunak (Software) yang dibutuhkan :

1. Arduino IDE

2. Library LoralD

3. Library Pendukung (DHT, dll)
4. Android Studio



Install Arduino IDE

Arduino IDE digunakan untuk membuat/menuliskan sebuah program yang selanjutnya akan
di-compile dan di-flash ke sebuah chip microcontroller contohnya Arduino (atmega, atxmega,
dil), WEMOS (esp8266, esp32), dan lain-lain. Untuk melakukan instalasi software Arduino IDE,
langkah-langkahnya sebagai berikut :

1. Download software di Arduino.cc

@ Arduino - Home x - x

e

C | @ Aman | https//www.arduino.cc

ARDUINO HOME BUY SOFTWARE PRODUCTS EDUCATION RESOURCES COMMUNITY HELP

> ARDUINO
©Q® ) > WEB EDITOR
> CODE ONLINE!

ese
i
N1 -
LEVITATE WATER DROPS WITH ol
"
2. Pilih Menu Software
@ Arduino - Software X e - 8 X
<« C | & Aman | https;//www.arduino.cc/en/Main/Software w e ME O 4@ @ a :
(o0} HOME BUY SOFTWARE PRODUCTS EDU RESOURCES COMMUNITY HELP Q @ sieNIN

Download the Arduino IDE

‘Windows installer
Windows ziP file for non admin install

ARDUINO 1.8.5

The open-source Arduino Softwar
e code and upload it to the board.

Mac 05 X, and Linux. The envi

Windows app Requires Win 810r10
easy 0 Get

% Mac 0S X107 Lion o
Linux 32 bits

Linux 64 bits

Linux ARM

he Getting Started page for Installation
instructions.

HOURLY BUILDS BETA BUILDS
3 January 2018 21:34:46 GMT

Download 2 preview of the incoming release with the most Download the Beta Version of the Arduino IDE with




3. Pilih system operasi yang sesuai

@ Arduino - Donate x

C | @& Aman | https;//www.arduino.cc/en/Main/Donate
p:

ARDUINO HOME BUY

SOFTWARE

Qa o

SIGN |

PRODUCTS EDUCATION RESOURCES COMMUNITY HELP

Contribute to the Arduino Software

Consider supporting the Arduino Software
is not tax deductible). Learn more on how

by contributing to its development. (US tax payers, please note this contribution
your contribution will be used

SINCE MARCH 2015, THE ARDUINO IDE HAS BEEN DOWNLOADED
PEORZYIEY[d TIMES. (IMPRESSIVE!) NO LONGER JUST FOR ARDUINO AND
GENUINO BOARDS, HUNDREDS OF COMPANIES AROUND THE WORLD ARE

USING THE IDE TO PROGRAM THEIR DEVICES

INCLUDING COMPATIBLES

CLONES, AND EVEN COUNTERFEITS

HELP ACCELERATE ITS DEVELOPMENT

WITH A SMALL CONTRIBUTION!

REMEMBER: OPEN SOURCE IS LOVE!

$3

$5

$10 $25 $50 OTHER

JUST DOWNLOAD CONTRIBUTE & DOWNLOAD

4. Pilih direktori penyimpanan

€ sSaveAs X
4 B > ThisPC > Desktop v O Search Desktop P
Organize v New folder E - (2]
Documents # * i
[&] Pictures b g Q
L. Google Drive # I
03. TELKOM DD¢ - :
arduino _MACOSX apache-jmeter-3. arduino HTTPSIES
DATA DIRI 3
POC Huawei
¢@& OneDrive
[ This PC 2 .
B e Dy v iotplatform Eclipse Java Google Drive Nmap - Zenmap v
File name: v ]
Save as type: 1 Application v

A Hide Folders

Save Cancel




5. Seletah download selesai, Lakukan instalasi dan pilih | agree

Arduino Setup: License Agreement -

P Please review the license agreement before installing Arduino. If you
O accept all terms of the agreement, dick I Agree.

,"':'NU LESSER GENERAL PUBLIC LICENSE
{ Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.ora/>

Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms
and conditions of version 3 of the GNU General Public License, supplemented
by the additional permissions listed below.

Cancel | Nullsoft Install System 3.0 I Agree

6. Ceklis semua pilihan, lalu Next

Arduino Setup: Installation Options — X

Check the components you want to install and uncheck the components
5.0 you don't want to install. Click Next to continue.

Select components to install: Install Arduino software
Install USB driver
Create Start Menu shortcut
Create Desktop shortcut
Assodiate .ino files

Space required: 420.6MB

Cancel | Mullsoft Install System 3.0 < Back Next >




7. Pilih destinasi penyimpanan

Arduino Setup: Installation Folder — 2%

Setup will install Arduino in the following folder. To install in a different
22) folder, dick Browse and select another folder. Click Install to start the

installation.

Browse...

{ Destination Folder

Space required: 420.6MB
Space available: 326.5GB

Cancel | Nullsoft Install System v3.0 < Back Install

8. Tunggu hingga selesai instalasi

Arduino Setup: Installing —_

Extract: command.h
|

Show details

Mullsaft Install System v3.0 = Back Close

9. Pilih Install apabila muncul kotak dialog seperti gambar dibawah.



Windows Security X

1 Would you like to install this device software?

Name: Adafruit Industries LLC Ports (COM & LPT...
S Publisher: Adafruit Industries

Always trust software from "Adafruit Industries”. Install | Don'tInstall |

@) You should only install driver software from publishers you trust. How can | decide
which device software is safe to install?

Arduino IDE telah terinstall dan siap untuk digunakan untuk membuat project

Install Library LoralD

1. Download library LoralD di https://git.antares.id/lorawan-loraid/arduino-loraid

This project  Search (o8 Sign in / Register

tails

A

arduino-loraid e
Simple LoRaWAN lora.id SDK Class A and C for Arduino/ESP8266 platform

 Star 0 HTTPS ~ https://git.antares.id/loraw Iy

Files (502 KB) Commits (17) Branch (1) Tags (2) Readme MIT License

10-loraid History Q Findfile & ~

Source code

1 about 6 hours ago )
Download zip

Download tar.gz
Last commit
Download tar.bz2

Set Power to 17dbm Download tar

Set Power to 17dbm about 6 hours ago
Set Power to 17dbm about 6 hours ago
Add .gitignore 6 months ago

fab | Set Power to 17dbm about 6 hours ago




Sebelum memulai proses pada software, Anda perlu menginstall Library Loraid pada Arduino IDE
yang Anda gunakan. Pada Arduino IDE, buka add .ZIP Library dengan klik Sketch > Include Library
>add .ZIP Library.

€9 sketch_sep27a | Arduino 1.8.6 — O X
File Edit Sketch Tools Help

Verify/Compile Ctrl+R
Upload Ctrl+U

sketch) Upload Using Programmer  Ctrl+Shift+U

void s Export compiled Binary Ctrl+Alt+S

Show Sketch Folder Ctrl+K Manage Libraries...  Ctrl+

e

} Include Library

Add ZIP Library...
Add File...

‘] iut your main code here, to run repeate Arduino libraries
Bridge

Esplora
Ethernet
Firmata

GSM

Keyboard
LiquidCrystal
Mouse

Robot Control
Robot IR Remote
Robot Motor
SD

Servo

SpacebrewYun

Stepper

ESP32 Dev Module, Disabled, Default, QIO, 80MHz, 4MB (: TFT

Kemudian pilih file zip Library Loraid pada direktori penyimpanan yang telah Anda download
sebelumnya. Lalu klik Open.



Look in: [ 8 Downloads

v 2@

'1.
e
Recent Items

3 . _ Previews
. 16.6_2015_OrCAD_Lite_Capture_PSpice
. Allegro-ACS712-breakout.PCB-master
. archive
. CodeVisionAVR2.05.3
. Compressed
. Docklight
= . Documents
[‘] . en.flasher-stm32
My Documents . en.flasher-stm32(2)
. en.stsw-1ink009

! " . english
- , fritzing.0.9.3b.64.pc

. PLX-DAQ
. Programs
. SOFTWARES_2
J TinyGPS-master
. Video
B 1676344-1(1)
B 1676344-1
g Adafruit_Sensor-master
B Allegro-ACS712-breakout. PCB-master
3 altium-library-master
3 antares-esp8266-http-master

<

. #Proteus v8.1 SP1 Pro Incl Crack - [MUMBAI-TPB] g Arduino-IRremote-master

. National Instruments LabVIEW 2017 v17 with Crack (x64) - softasm.com 3 fritzing.0.9.3b.64.pc

g ArduinoJson-6.1.0-beta

g arduino-loraid-master-362bc7a4a185c6d2f2ff03
& DFRobot_SIM7000-master(1)
& DFRobot_SIM7000-master
g DHT _sensor_library-1.3.0
3 DHT-sensor-library-master
3 DigitalWriteFast-master

& Docklight

8 ps3231

B enflasher-stm32(1)

B enflasher-stm32(2)

g en.flasher-stm32

@ en.stsw-1ink009

8 12Cdev

& MPU6050

B nRF51822-Arduino-5130

B nRF51822-Arduino-5130_corelib
g Relay-master

Q SD-master

B SIM7000-LTE-Shield-master

B TinyGPS-master

>

File name: ‘Ioraid 2.zip

[_open |

Files of type: IZIP files or folders

Cancel

Set LoRa di Antares

Sebelum device mengirim data, terlebih dahulu harus dibuatkan penampung data nya di Antares.
Dengan cara buat application, deviice . setelah device dibuat maka device tersebut harus di set

LoRa class A.

= & ANTARES

GENERAL Home / Applications / ArduinoLORA / GetData
A Overview
n GetData
¥ Applications DEVICE
88 Widgets [ ceta ]
Manage your device here. You can subscribe to this
Documentation & device, manage user access key, view real time device
data, etc.
£ Account
& Users

©® How toSend Data

N Subscribe E

& Data (8 SetloRa

Hierarchical URI
https://platform.antares.id:8443/~/antares-cse/antares-id/ArduinoLORA/GetData o

Non-hierarchical URI

https://platform.antares.id:8443/~/antares-cse/cnt-82041161 o

© How to Subscribe to Device Data



Set LoRa Device

--Select LoRa Device Class --

Are you sure you want to set this device as LoRa device?

Membuat Firmware Antares LR201 Board

1. Example Class A

Setelah sebelumnya menginstall library LoralD, maka pada file =» example =» LoralD =» class A

File Edit Sketch Tools Help

New #N A

Open... #0  Adafruit NeoMatrix

Open Recent > Adafruit NeoPixel

Sketchbook Adafruit PWM Servo Driver Library

Examples Adafruit SGP30 Sensor

Close Adafruit SSD1306

Save ADS1110

Save As... antares-arduinoUno

Page Setup o%p antares-esp-mqtt-master

Print antares-esp32-http-master
va antares-esp8266-http-master
ousMillis ) i Antares_SIM7000-master

Ay 'Y VVV

nt counter = 0; Arduino-MPU6050-master

TPIN, DHTTYPE); Arduino-Websocket-Fast
ArduinoJson

04 ArduinoThread

loraid access base64

tO; BH1750

ORaWAN Class blunoAccessory

DeviceClass(CLASS_A); BridgeHttpClient
ClosedCube HDC1080

ata Rate ClosedCube TCAS546A

DataRate(2); Crc16-master

ntares Key and DevAddress hEN et A

PR TIENPYPPINIPRIP  DHT sensor library
DS3231
ds3231-master
ESP Async UDP
GPRS_SIMS00-master
Grove - Multichannel Gas Sensor
Grove - RTC DS1307
HID-Project
12Cdevlib-ADS1115
IBM LMIC framework
ITEADLIB_Arduino_Nextion-master
Joba Ts|2561 Library
LiquidCrystal_PCF8574
LoRa
LoralD
MPUG050

T W W WWWWWNRNNNNNRNNNRNR e

loraid-send-class-A
loraid-send-class-C

VYV VVVV VYV VYV VY VY VYYYYYYYYYYYYYYYYYY



Pada Arduino IDE, konfigurasikan Arduino Pro or Pro Mini sebagai board yang akan Anda
gunakan. Klik Tools > Board > Arduino Pro or Pro Mini. Konfigurasikan Processor ATmega328P
(3.3 V,8 MHz) sebagai processor yang akan Anda gunakan. Klik Tools > Processor > ATmega328P
(3.3 V,8 MHz). Konfigurasikan Port sesuai dengan Board Arduino LoRa yang Anda gunakan. Klik
Tools > Port > COM ....

@00 loraid-send-class-A | Arduino 1.8.1

loraid-send-class-A §

1
2
3
4
5

#include <loraid.h>

long interval = 10000; // 1@ s interval to send message
long previousMillis = @; // will store last time message sent
unsigned int counter = 0; // message counter

Blvoid setup() {
// Setup loraid access
lora.initQ);

0 oo~y

1

=
)= ®

// Set LoRaWAN Class
lora.setDeviceClass(CLASS_A);

e el
S W

// Set Data Rate
lora.setDataRate(3);

[y
oy

17 // Put Antares Key and DevAddress here
18 lora.setAccessKey("your-access-key");
19 lora.setDeviceId("your-lora-addr");

21

J

Blvoid loop() {
// put your main code here, to run repeatedly:
char myStr[50];
char outStr[255];
int recvStatus = @;

v s wr

unsigned long currentMillis = millisQ);

WIN NN NN MNNT
o)

S W oo~

// Check interval overflow

318 1if(currentMillis - previousMillis > interval) {

32 previousMillis = currentMillis;

33

34 sprintf(myStr, "Ini data LoRa ke-%d", counter);

35 lora.sendToAntares((unsigned char *)myStr, strlen(myStr), @);
36 counter++;

37 }

20

Pada baris 18 diubah sesuaikan dengan access key dari account Antares anda. Baris 19 disesuiakn

dengan device addr di Antares. Pada baris ke 34, anda dapat mengubah data yang akan dikirim



maksimal 50 byte. Setelah itu tekan tombol upload. Setelah selesai upload, tunggu beberapa saat

sampai data muncul di Antares.

& ANTARES

GENERAL
Data
A Overview
Latest (Real Time) Historical
S Applications
Time Resource Index (ri) Data
88 Widgets [ Beta )
2018-11-07 20:25:18 /antares-cse/cin-200202984
& Documentation & Ini data LoRa ke-0
£ Account
2018-11-07 20:25:07 /antares-cse/cin-539029300
B = Ini data LoRa ke-0
2018-11-07 20:24:55 /antares-cse/cin-929928020
Ini data LoRa ke-0
2018-11-07 20:24:46 /antares-cse/cin-304402529

Ini data LoRa ke-©@



2. Kirim Data Sensor Suhu dan Humidity

#include <loraid.h>
#include "DHT.h"
#define DHTPIN 4
#define DHTTYPE DHT11

long interval = 10000; // 10 s interval to send message
long previousMillis = 0; // will store last time message sent
unsigned int counter = 0; // message counter
DHT dht(DHTPIN, DHTTYPE);
void setup() {
// Setup loraid access
lora.init();
// Set LoRaWAN Class
lora.setDeviceClass(CLASS_A);
// Set Data Rate
lora.setDataRate(2);
// Put Antares Key and DevAddress here
lora.setAccessKey("your-access-key");
lora.setDeviceld("dev addr lora");

dht.begin();




void loop() {
char myStr[50];
char outStr[255];

int recvStatus = 0;

unsigned long currentMillis = millis();

if(currentMillis - previousMillis > interval) {
float h = round(dht.readHumidity());

float t = round(dht.readTemperature());

if (isnan(h) | | isnan(t)) {
h=0;

t=0;

}

previousMillis = currentMillis;

String dataKirim = lora.makeData(1, 2, 0, (String)t,(String)h,"");
Serial.printIn((String)dataKirim);

dataKirim.toCharArray(myStr, dataKirim.length()+1);

lora.sendToAntares((unsigned char *)myStr, strlen(myStr), 0);

recvStatus = lora.readData(outStr);
if(recvStatus) {

Serial.printIn(outStr);

}

lora.update();

}




Data

Latest (Real Time) Historical

Time Resource Index (ri) Data

2018-11-22 18:57:45 /antares-cse/cin-428984555

"temperature": "23.00",
"humidity": "71.00"

2018-11-22 18:57:41 /antares-cse/cin-54429491

"temperature": "23.00",
"humidity": "71.00"



